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A Few Words WOYYTV Jik ""‘"*’Q

ABOUT THIS KIT

The overall goal of this kit is fun. Beyond this, the aim is to get you

comfortable using a wide range of electronic components through

small, simple and easy circuits. The focus is to get each circuit

working then giving you the tools to figure out why. If you encounter

any problems, want to ask a question, or would like to know more
Qbout any part, extra help is only an e-mail away help@oomlout.com.

ABOUT OPEN SOURCE HARDWARE

All of .:oomlout:.'s projects are open source. What does this mean? It means everything involved in
making this kit, be it this guide, 3D models, or code is available for free download. But it goes
further, you're also free to reproduce and modify any of this material, then distribute it for yourself.
The catch? Quite simple, it is released under a Creative Commons (By - Share Alike) license. This

means you must credit .:oomlout:. in your design and share your developments in a similar manner.
Why? We grew up learning and playing with open source software and the experience was good
fun, we think it would be lovely if a similar experience was possible with physical things.

More details on the Creative Commons CC (By - Share Alike) License can be found at
\ http://ardx.org/CCLI j

ABOUT .: OOMLOUT ..

We’'re a plucky little design company focusing on producing
“delightfully fun open source products”

To check out what we are up to

http://www.oomlout.com

ABOUT SOLARBOTICS

We started out doing BEAM robot kits over 15 years ago (really!), and now we
also supply clever electronic bits & kits
http://www.solarbotics.com/

ABOUT PROBLEMS
We strive to deliver the highest level of quality in each and every thing we produce. If you ever find an
ambiguous instruction, a missing piece, or would just like to ask a question, we’ll try our best to help out.

help@oomlout.com / help@solarbotics.com
(we like hearing about problems it helps us improve future versions)

Thanks For Choosing .:.oomlout:.
(and Solarbotics)
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: For an introduction to what an Arduino is
> http://ardx.org/ZINTR :.
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INSTALLING THE IDE :.

This is the program used to write code for the Arduino. It may
seem a little daunting at first but once you have it installed and
start playing around, its secrets will reveal themselves.

O2 INST

installing
(software and hardware)

Step 1: Download the software

Go to

http://arduino.cc/en/Main/Software
download the software for your operating system

Windows XP

Step 2: Unzip the Software

Unzip
arduino-1. X-windows.zip (X- version #)
Recommended Path

c:\Program Files\

Step 3: Shortcut Icon
Open
c:\program files\arduino-1. X\ (X- version #)
Right Click

Arduino.exe (send to>Desktop (create shortcut))

board into a free USB port.
Wait for a box to pop up

Step 4: Plug In Your Arduino
Plug your Arduino in:
Using the included USB cable, plug your Arduino

ick “Install from a list or specific location (Advanced)")
Choose the Location
c:\program files\arduino-00 X X \drivers\
Finished

Step 5: Add new Hardware
Skip searching the internet
(click the next box when prompted to do so)
Install from a specific location
(cl

Vista, Seven
/ Step 5: Add new Hardware\

Run Device Manager
Start > Run > devmgmt.msc
Choose the Arduino
Other Devices > Arduino Uno (Uno)

Update Driver
click “Update Driver”

Select Driver
click “Browse My Computer for Driver Software”

c:\program files\arduino-1. X \drivers\
\ Finished /

Mac OSX
Step 2: Open The .dmg

Open (mount)
arduino-1. X -macosxX.zip (x- version #)

Step 3: Copy The Application
Go to

"Arduino" (in the devices section of finder)

Move
"Arduino” Application to the
"Applications" folder

Step 4: Plug In Your Arduino

Plug your Arduino in:
Using the included USB cable, plug your Arduino
board into a free USB port.

Finished

.o NOTE: :.
.. Encountering problems? :.
. Would like more details? Using Linux? :.
.» http://ardx.org/LINU :.
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ARDUINO PROGRAMMING IN BRIEF

..A Small Programming Primer-:.

The Arduino is programmed in the C language. This is a quick little primer targeted at people
who have a little bit of programing experience and just need a briefing on the idiosyncracies of C
and the Arduino IDE. If you find the concepts a bit daunting, don't worry, you can start going
through the circuits and pick up most of it along the way. For a more in-depth intro, the
Qrduino.cc website is a great resource.

J

STRUCTURE

Each Arduino program
(often called a sketch) has
two required functions
(also called routines).

void setupQOQ{ }
All the code between the two
curly brackets will be run once
when your Arduino program
first runs.

void loop(O{ }

This function is run after setup
has finished. After it has run
once it will be run again, and
again, until power is removed.

\_

SYNTAX

e

\_

One of the slightly
frustrating elements of C is
its formatting requirements
(this also makes it very
powerful). If you remember
the following you should be

alright.

J

// (single line comment)
It is often useful to write notes
to yourself as you go along
about what each line of code
does. To do this type two
forward slashes and everything
until the end of the line will be
\ignored by your program.

{ } (curly brackets)
Used to define when a block

of code starts and ends (used

L in functions as well as loops). )

( )

/> */(multi line comment)
If you have a lot to say you can
span several lines as a
comment. Everything between
these two symbols will be
ignored in your program.

\

-
, (semicolon)

Each line of code must be
ended with a semicolon (a
missing semicolon is often
the reason for a program
_ refusing to compile).

VARIABLES

N
A program is nothing more

than instructions to move
numbers around in an
intelligent way. Variables are

L used to do the moving.

int (integer)
The main workhorse, stores a
number in 2 bytes (16 bits).
Has no decimal places and will
store a value between -32,768
L and 32,767.

long (long)
Used when an integer is not

large enough. Takes 4 bytes (32
bits) of RAM and has a range
between -2,147,483,648 and
\2,147,483,647.

boolean (boolean)
A simple True or False
variable. Useful
because it only
uses one bit of

RAM.

float (float)
Used for floating point math
(decimals). Takes 4 bytes (32
bits) of RAM and has a range
between -3.4028235E+38

and 3.4028235E+38.
4

char (character)
Stores one character using the
ASCII code (ie ‘A" = 65). Uses
one byte (8 bits) of RAM. The
Arduino handles strings as an
array of char’s.

—/




..For a full programming reference visit:.
http://ardx.org/PROG

MATHS OPERATORS

O3 PROG

programming
primer

Operators used for
manipulating numbers.
(they work like simple
maths).

\_

(assignment) makes something equal to something else (eg. x

= 10 * 2 (x now equals 20))

(modulo) gives the remainder when one number is divided by
another (ex. 12 % 10 (gives 2))

(addition)
(subtraction)
(multiplication)
(division)

COMPARISON OPERATORS

Operators used for
logical comparison.

\_

== (equal t0) (eg. 12 == 10 is FALSE or 12 == 12 is TRUE)
(not equal to) (eg. 12 1= 10 is TRUE or 12 I= 12 is FALSE)
(less than) (eg. 12 < 10 is FALSE or 12 < 12 is FALSE or 12 < 14 is TRUE)
(greater than) (eg. 12 > 10 is TRUE or 12 > 12 is FALSE or 12 > 14 is

FALSE)

J

CONTROL STRUCTURE

( )
Programs are reliant on
controlling what runs

next, here are the basic
control elements (there

are many more online).

\_

if(condition){ } h

else if( condition ){ }
else { }

This will execute the code between
the curly brackets if the condition
is true, and if not it will test the
else if condition if that is also
false the else code will execute.

for(int 1 = 0; 1 <
#repeats; 1++){ }
Used when you would like to
repeat a chunk of code a number
of times (can count up i++ or
down i-- or use any variable)

J

DIGITAL

e N
pinMode(pin, mode);
Used to set a pin's mode, pin

is the pin number you would

like to address 0-19 (analog O-

5 are 14-19). The mode can

digitalWrite(pin, value);
Once a pin is set as an OUTPUT,
it can be set either HIGH (pulled
to +5 volts) or LOW (pulled to
ground).

either be INPUT or OUTPUT.

int digitalRead(pin);
Once a pin is set as an INPUT
you can use this to return
whether it is HIGH (pulled to
+5 volts) or LOW (pulled to
ground).

J

The Arduino is a digital
machine but it has the ability
to operate in the analog
realm (through tricks).
Here's how to deal with
things that aren't digital.

(int analogWrite(pin,

\255 (100% duty cycle ~5 volts).

value);
Some of the Arduino's pins support
pulse width modulation (3, 5, 6, 9, 10,
11). This turns the pin on and off very
quickly making it act like an analog
output. The value is any number
between 0 (0% duty cycle ~0v) and

( int analogRead(pin);

.

When the analog input pins are set
to input you can read their voltage.
A value between 0 (for O

volts) and 1024 (for

5 volts) will be

returned.

S
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.-A Small Electronics Primer:.

ELECTRONICS IN BRIEF

No previous electronic experience is required to have fun with this kit. Here are a few details
about each component to make identifying, and perhaps understanding them, a bit easier. If

at any point you are worried about how a component is used or why it's not working the
internet offers a treasure trove of advice, or we can be contacted at help@oomlout.com

COMPONENT DETAILS

LED

(Light Emitting Diode)

Transistor

®

What it Does:

Emits light when a small current is
passed through it. (only in one direction)
Identifying:

Looks like a mini light bulb.

No. of Leads:
2 (one longer, this one connects to positive)
Things to watch out for:

- Will only work in one direction

- Requires a current limiting resistor
More Details:

http://ardx.org/LED

What it Does:

The electronic equivalent of a one way
valve. Allowing current to flow in one
direction but not the other.

Identifying:

Usually a cylinder with wires extending from
either end. (and an off center line indicating polarity)

No. of Leads:
2
Things to watch out for:

- Will only work in one direction (current wil
flow if end with the line is connected to ground)

More Details:
http://ardx.org/DIOD

What it Does:

Restricts the amount of current that can
flow through a circuit.

Identifying:

Cylinder with wires extending from either
end. The value is displayed using a color
coding system (for details see next page)

No. of Leads:
2
Things to watch out for:

- Easy to grab the wrong value (double
check the colors before using)
More Details:
http://ardx.org/RESI

What it Does:

Uses a small current to switch or amplify a
much larger current.

Identifying:

Comes in many different packages but you

can read the part number off the package.
(P2N2222AG in this kit and find a datasheet online)

No. of Leads:
3 (Base, Collector, Emitter)
Things to watch out for:
- Plugging in the right way round (aiso a

current limiting resistor is often needed on the base pin)
More Details:

http://ardx.org/TRAN

Hobby Servo What it Does:

Takes a timed pulse and converts it into
an angular position of the output shaft.
Identifying:

A plastic box with 3 wires coming out one
side and a shaft with a plastic horn out
the top.

No. of Leads:
3
Things to watch out for:
- The plug is not polarized so make sure
it is plugged in the right way.
More Details:
http://ardx.org/SERV

What it Does:

Spins when a current is passed through it.
Identifying:

This one is easy, it looks like a motor.
Usually a cylinder with a shaft coming out
of one end.

No. of Leads:
2
Things to watch out for:
- Using a transistor or relay that is rated
for the size of motor you're using.
More Details:
http://ardx.org/MOTO /
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Piezo Element
What it Does:
A pulse of current will cause it to click. A No. of Leads:
stream of pulses will cause it to emit a 2
tone. Things to watch out for:
Identifying: - Difficult to misuse.
In this kit it comes in a little black barrel, More Details:
but sometimes they are just a gold disc. http://ardx.org/PIEZ
IC (Integrated Circuit)
What it Does: No. of Leads:
Packages any range of complicated 2 - 100s (in this kit there is one with 3 (TMP36) and
electronics inside an easy to use package. one with 16 (74HC595)
Identifying: Things to watch out for:
The part ID is written on the outside of the - Proper orientation. (look for marks showing pin 1)
package. (this sometimes requires a lot of More Details:
light or a magnifying glass to read). http://ardx.org/ICIC

What it Does: No. of Leads:
Completes a circuit when it is pressed. 4
Identifying: Things to watch out for:
A little square with leads out the bottom - these are almost square so can be
and a button on the top. inserted 90 degrees off angle.
More Details:
http://ardx.org/BUTT

Potentiometer
What it Does: No. of Leads:

Produces a variable resistance dependant 3

They can be packaged in many different More Details:
form factors, look for a dial to identify. http://ardx.org/POTE

a * on the angular position of the shaft. Things to watch out for:
v Identifying: - Accidentally buying logarithmic scale.

Photo Resistor
What it Does: No. of Leads:

Produces a variable resistance dependant 2
on the amount of incident light. Things to watch out for:
Identifying: - Remember it needs to be in a voltage
Usually a little disk with a clear top and a divider before it provides a useful input.
curvy line underneath. More Details:

http://ardx.org/PHOT j

RESISTOR COLOR CODE irst digit LEAD CLIPPING

Examples: Some components in this kit come with very long wire
green-blue-brown - 560 ohms leads. To make them more compatible with a breadboard
red-red-red - 2 200 ohms (2.2k) a couple of changes are required.
brown-black-orange - 10 000 ohms (10k tolerance LEDS'? g a

Clip the leads so the long lead is ~10mm (3/8") long and

the short one is ~7mm (9/32”).

Resistors:

Bend the leads down so they are 90 degrees to the

MO - Black 5 - Green 20% - none cylinder. Then snip them so they are ~6mm

M1 - Brown M6 - Blue 10% - silver (1/4”) long.

W2 - Red m7- Purple 5% - gOId 8::5222&22:21:2; need clipping
M3 - Orange M8 - Grey '

- Use your discretion when doing so.
\ 4 - Yellow []9 - White )




:Getting Started:
..(Blinking LED):

WHAT WE'RE DOING:

LEDs (light emitting diodes) are used in all sorts of clever things
which is why we have included them in this kit. We will start off
with something very simple, turning one on and off, repeatedly,
producing a pleasant blinking effect. To get started, grab the parts
listed below, pin the layout sheet to your breadboard and then plug
everything in. Once the circuit is assembled you'll need to upload the program. To do this plug the
Arduino board into your USB port. Then select the proper port in Tools > Serial Port > (the
comm port of your Arduino). Next upload the program by going to File > Upload (ctrl+U).
Finally, bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://ardx.org/TRBL

- J

THE CIRCUIT:

aikis CIRC-01 . iy
1 i 2 Pin Head f--d 10mm LED
5 Breadboard Sheet ih Reader oa /"_'\\ Wire

<1 x4

560 Ohm Resistor
Green-Blue-Brown
x1

Schematlc

Arduino
pin 13

Ionger lead

LED
(light emitting diode)

resistor (560ohm)
(green-blue-brown)

)

gnd
(ground) (-)

.:download:.
breadboard layout sheet
http://ardx.org/BBLS01
view:.
assembly video
http://ardx.org/VIDEO1




COD E (no need to type everything in just click) C I R C —_— O 1

File > Examples > 1.Basic > Blink
(example from the great arduino.cc site, check it out for other ideas)

Blink
Turns on an LED on for one second, then off for one second,
repeatedly.
Created 1 June 2005 By David Cuartielles
http://arduino.cc/en/Tutorial/Blink
based on an orginal by H. Barragan for the Wiring i/0 board
*
/

int ledPin = 13; // LED connected to digital pin 13

// The setup() method runs once, when the sketch starts
void setup() { // initialize the digital pin as an output:
pinMode(ledPin, OUTPUT); 3}

// the loop() method runs over and over again,

// as long as the Arduino has power

void loop() {
digitalWrite(ledPin, HIGH); // set the LED on
delay(1000); // wait for a second
digitalWrite(ledPin, LOW); // set the LED off
delay((1000); // wait for a second

\

4 NOT WORKING? (4 things to try)

\

4 N
LED Not Lighting Up? Program Not Uploading
LEDs will only work in one This happens sometimes, Still No Success?
direction. Try taking it out and the most likely cause is a A broken circuit is no fun, send
reversing it. No need to worry - . -mai i
9 y confused serial port, you us an e-mail and we will get

installing it backwards does no o back to you as soon as we can.
permanent harm). can change this in

Also, make sure you are tools>serial port>
connecting to pin 13!

help@oomlout.com

\J

4 MAKING IT BETTER

Changing the pin: Control the brightness:
The LED is connected to pin 13 but we can use any of Along with digital (on/off) control the Arduino can control

the Arduino’s pins. To change it take the wire plugged some pins in an analog (brightness) fashion. (more details on
into pin 13 and move it to a pin of your choice (from 0- this in later circuits). To play around with it.

13) (you can also use analog 0-5, analog 0 is 14...) Change the LED to pin 9: (also change the wire)
ledPin = 13; -> int ledPin = 9;

Then in the code change the line:
int ledPin = 13; -> int ledPin = newpin; Replace the code inside the { }'s of loop() with this:

Then upload the sketch: (ctrl-u) analogWrite(ledPin, new number);

Change the blink time: (new number) = any number between 0 and 255.
Unhappy with one second on one second off? 0 = off, 255 = on, in between = different brightness

In the code change the lines: Fading:
digitalWrite(ledPin, HIGH); We will use another included example program. To open go to
delay(time on); //(seconds * 1000)
digitalWrite(ledPin, LOW);
delay(time off); //(seconds * 1000) Then upload to your board and watch as the LED fades in and

then out. j

File > Examples > 3.Analog > Fading

MORE, MORE, MORE:
More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO1




.:8 LED Fun:.
.:Multiple LEDs:.

WHAT WE’RE DOING:

We have caused one LED to blink, now it's time to up the
stakes. Lets connect eight. We'll also have an opportunity to
stretch the Arduino a bit by creating various lighting

sequences. This circuit is also a nice setup to experiment with
writing your own programs and getting a feel for how the Arduino works.

Along with controlling the LEDs we start looking into a few simple programming methods to
keep your programs small.

for () loops - used when you want to run a piece of code several times.
arrays[] - used to make managing variables easier (it's a group of variables).

J

THE CIRCUIT:

. CIRC-02

;2 Pin Header 5mm Green LED
Breadboard Sheet  # |, 8 x8 f—\ Wire
x1

560 Ohm Resistor
Green-Blue-Brown
X8

pin 2 pin 3 pin 4 pin 5

LED

resistor
5600hm
—gnd

pin 6 pin 7 pin 8 pin 9

LED
resistor
5600hm

k —gnd

.:download:.
breadboard layout sheet
http://ardx.org/BBLS02
view:.
assembly video
http://ardx.org/VIDEO2




COD E (no need to type everything in just click)

//LED Pin Variables

int ledPins[] = {2,3,4,5,6,7,8,9};
//An array to hold the
//pin each LED is connected to
//i.e. LED #0 is connected to pin 2

void setup()

for(int i = 0; i < 8; i++){
//this is a loop and Wl|| repeat eight times
pinMode(ledPins[i],0UTPUT
) //we use this to set LED plns to output
¥
void loop(Q) // run over and over again
oneAfterAnotherNoLoop();
//this will turn on each LED one by
//one then turn each oneoff
//oneAfterAnotherLoop();
//this does the same as onAfterAnotherNoLoop
//but with much less typing
//0neOnAtATime();
//inAndOut(Q);

/*
* oneAfterAnotherNoLoop() - Will light one then
* delay for delayTime then light the next LED it

* will then turn them off

Download the Code from (http://ardx.org/CODEO02)
(and then copy the text and paste it into an empty Arduino Sketch)

void oneAfterAnotherNoLoop(){

int delayTime = 100;
//the time (in mllllseconds) to pause
//between LEDs
digitalWrite(ledPins[0], HIGH); //Turns on LED #0
//(connected to pin 2)

delay(delayTime); //waits delayTime milliseconds

aiéitaIWrite(ledPins[7], HIGH); //Turns on LED #7
//(connected to pin 9)

delay(delayTime); //waits delayTime milliseconds

//Turns Each LED Off

digitalWrite(ledPins[7],
delay(delayTime);

LOW); //Turns off LED #7
//waits delayTime milliseconds

( NOT WORKING? (3 things to try)

4 \ [

Some LEDs Fail to Light
It is easy to insert an LED

backwards. Check the LEDs
that aren't working and ensure
they the right way around.

Operating out of sequence
With eight wires it's easy to cross

a couple. Double check that the
first LED is plugged into pin 2 and
each pin there after.

Starting Afresh
Its easy to accidentally

misplace a wire without
noticing. Pulling everything out
and starting with a fresh slate
is often easier than trying to
track down the problem.

\J

4 MAKING IT BETTER

Switching to loops:
In the loop() function there are 4 lines. The last
three all start with a '//'. This means the line is
treated as a comment (not run). To switch the
program to use loops change the void loop()
code to:

//oneAfterAnotherNoLoop();

oneAfterAnotherLoop();

//0neOnAtATime();

//inAndout();
Upload the program, and notice that nothing has
changed. You can take a look at the two
functions, each does the same thing, but use
different approaches (hint: the second one uses

Ka for loop).

Extra animations:
Tired of this animation? Then try the other two

sample animations. Uncomment their lines and upload
the program to your board and enjoy the new light
animations. (delete the slashes in front of row 3 and then 4)

Testing out your own animations:
Jump into the included code and start changing

things. The main point is to turn an LED on use
HIGH) ; then to turn
LOW) ;

Type away, regardless of what you change you won't
break anything.

digitalWrite(pinNumber,
it off use digitalWrite(pinNumber,

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC0O2




.:Spin Motor Spin:.
.:Transistor & Motor:.

WHAT WE'RE DOING:

The Arduino's pins are great for directly controlling small electric
items like LEDs. However, when dealing with larger items (like a
toy motor or washing machine), an external transistor is required. A
transistor is incredibly useful. It switches a lot of current using a
much smaller current. A transistor has 3 pins. For a negative type (NPN)
transistor, you connect your load to collector and the emitter to ground. Then when a small current
flows from base to the emitter, a current will flow through the transistor and your motor will spin
(this happens when we set our Arduino pin HIGH). There are literally thousands of different types of
transistors, allowing every situation to be perfectly matched. We have chosen a P2N2222AG a rather
common general purpose transistor. The important factors in our case are that its maximum voltage
(40v) and its maximum current (600 milliamp) are both high enough for our toy motor (full details
can be found on its datasheet http://ardx.org/2222).

(The 1N4001 diode is acting as a flyback diode for details on why its there visit: http://ardx.org/4001)

\ J

CIRC-03 Transistor

' 2 Pin Header n P2N2222AG (TO92) Wire
)E(’;eadboard Sheet i\i 4 it 1 /—\

Diode . 2.2k Ohm Resistor
(1N4001) Red-Red-Red
X1 X1

i The transistor will have
Schematic P2N2222AG printed on it
Arduino (some variations will have
pin 9 the pin assignment reversed)

Toy Motor f
| x1 I

Transistor
Base] P2N2222AG

Collector Emitter

gnd-
(ground) (-)

+5 volts /

.:download:.
breadboard layout sheet
http://ardx.org/BBLS03
.view:.
assembly video
http://ardx.org/VIDEO3

.:NOTE__if'your arduino is resetting (indicated by a pin13 LED blink),
youneed to install the optional capacitor:. /




COD E (no need to type everything in just click)

Download the Code from ( http://ard

x.org/CODEO3)

(then simply copy the text and paste it into an empty Arduino Sketch)

int motorPin = 9; //pin the motor is connected to
void setup() //runs once

pinMode(motorPin, OUTPUT);

void loop() // run over and over again
motorOnThenOff();
//motorOnThenOffWithSpeed();
//motorAcceleration();

/*
* motorOnThenOff() - turns motor on then off
* (notice this code is identical to the code we

used for

* the blinking LED)

*/

void motorOnThenOfF(){
int onTime = 2500; //on time
int offTime = 1000; //off time
digitalWrite(motorPin, HIGH);

// turns the motor On
delay(onTime); // waits for onTime milliseconds
digitalWrite(motorPin, LOW);

// turns the motor Off
delay(offTime);// waits for offTime milliseconds

\.

void motorOnThenOffWithSpeed(){
int onSpeed = 200;// a number between
//0 (stopped) and 255 (full speed)
int onTime = 2500;
int offSpeed = 50;// a number between
//0 (stopped) and 255 (full speed)
int offTime = 1000;
analogWrite(motorPin, onSpeed);
// turns the motor On
delay(onTime); // waits for onTime milliseconds
analogWrite(motorPin, offSpeed);
// turns the motor Off
delay(offTime); // waits for offTime milliseconds

}

void motorAcceleration(){
int delayTime = 50; //time between each speed step
for(int 1 = 0; i < 256; i++){
//goes through each speed from 0 to 255
analogWrite(motorPin, i); //sets the new speed
delay(delayTime);// waits for delayTime milliseconds

b5
for(int i = 255; i >= 0; i--){
//goes through each speed from 255 to O
analogWrite(motorPin, i); //sets the new speed
delay(delayTime);//waits for delayTime milliseconds

J

( NOT WORKING? (3 things to try)

~

4 \ [

Still Not Working?

Motor Not Spinning?
If you sourced your own
transistor, double check with
the data sheet that the pinout
is compatible with a P2N2222A
(many are reversed).

Still No Luck?

If you sourced your own
motor, double check that it will
work with 5 volts and that it
does not draw too much
power.

Sometimes the Arduino board
will disconnect from the
computer. Try un-plugging and
then re-plugging it into your
USB port.

\J

2/

4 MAKING IT BETTER

Controlling speed:
We played with the Arduino's ability to control the

brightness of an LED earlier now we will use the same
feature to control the speed of our motor. The Arduino
does this using something called Pulse Width
Modulation (PWM). This relies on the Arduino's ability to
operate really, really fast. Rather than directly
controlling the voltage coming from the pin the Arduino
will switch the pin on and off very quickly. In the
computer world this is going from 0 to 5 volts many
times a second, but in the human world we see it as a
voltage. For example if the Arduino is PWM'ing at 50%
we see the light dimmed 50% because our eyes are not
quick enough to see it flashing on and off. The same
feature works with transistors. Don't believe me? Try it

\out.

In the 1oop() section change it to this

// motorOnThenOff();
motorOnThenOffWithSpeed();

// motorAcceleration();

Then upload the programme. You can change the speeds by

changing the variables onSpeed and offSpeed.

Accelerating and decelerating:
Why stop at two speeds, why not accelerate and decelerate

the motor. To do this simply change the loop() code to read

// motorOnThenOFff();

// motorOnThenOffWithSpeed();
motorAcceleration();

Then upload the program and watch as your motor slowly
accelerates up to full speed then slows down again. If you
would like to change the speed of acceleration change the
variable delayTime (larger means a longer acceleration time).

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO3




.:A Single Servo..

.:Servos.:.

WHAT WE'RE DOING:

Spinning a motor is good fun but when it comes to projects
where motion control is required they tend to leave us
wanting more. The answer? Hobby servos. They are mass
produced, widely available and cost anything from a couple of
dollars to hundreds. Inside is a small gearbox (to make the movement more powerful) and

some electronics (to make it easier to control). A standard servo is positionable from 0 to

180 degrees. Positioning is controlled through a timed pulse, between 1.25 milliseconds (0
degrees) and 1.75 milliseconds (180 degrees) (1.5 milliseconds for 90 degrees). Timing
varies between manufacturer. If the pulse is sent every 25-50 milliseconds the servo will run
smoothly. One of the great features of the Arduino is it has a software library that allows
Qou to control two servos (connected to pin 9 or 10) using a single line of code. j

THE CIRCUIT:

CIRC-04 . .
i 2 PinH L 3 Pin Header
Breadboard Sheet a in Header d X1 /—\\ Wire

x1

Mini Servo
X1

Arduino
pin 9

Mini Servo

(ground) (-)

.:download:.
breadboard layout sheet
http://ardx.org/BBLS04
view:.
assembly video
http://ardx.org/VIDEO4




COD E (no need to type everything in just click)

File > Examples > Servo > Sweep
(example from the great arduino.cc site, check it out for other great ideas)

// Sweep
// by BARRAGAN <http://barraganstudio.com>

#include <Servo.h>
Servo myservo; // create servo object to control a servo
int pos = 0; // variable to store the servo position

void setup() {
myservo.attach(9); // attaches the servo on pin 9 to the servo object

void loop() {
for(pos = 0; pos < 180; pos += 1) // goes from O degrees to 180 degrees
{ // in steps of 1 degree
myservo.write(pos); // tell servo to go to position in variable "pos®
delay(15); // waits 15ms for the servo to reach the position

for(pos = 180; pos>=1; pos-=1) // goes from 180 degrees to O degrees
{

myservo.write(pos); // tell servo to go to position in variable “pos®
delay(15); // waits 15ms for the servo to reach the position

}
\"_ /

( NOT WORKING? (3 things to try) \

a N f N
Fits and Starts

Still Not Working If the servo begins moving then

A mistake we made a time or twitches, and there's a flashing

two was simply forgetting to light on your Arduino board, the
connect the power (red and power supply you are using is
brown wires) to +5 volts and not quite up to the challenge.

ground. Using a fresh battery instead of

USB should solve this problem.

\J 2/

Potentiometer control: void Toop() {

We have yet to experiment with inputs but if you would like int pulseTime = 2100; Z(the numbir o{ microsegonds
. - to pause for (1500 90 degrees
to read ahead, there is an example program File > Servo > N ) 77 900 0 degrees 2100 180 degrees)
Knob. This uses a potentiometer (CIRCO8) to control the digitalWrite(servoPin, HIGH):
delayMicroseconds(pulseTime);
servo. You can find instructions online here: digitalWrite(servoPin, LOW);

delay(25);
http://ardx.org/KNOB e

Servo Not Twisting?
Even with colored wires it is
still shockingly easy to plug a
servo in backwards. This might
be the case.

Self timing: Great ideas:
While it is easy to control a servo using the Arduino's included ~ Servos can be used to do all sorts of great things, here are a few of
library sometimes it is fun to figure out how to program our favorites.
something yourself. Try it. We're controlling the pulse directly .
. Xmas Hit Counter
so you could use this method to control servos on any of the http://ardx.org/XMAS
Arduino's 20 available pins (you need to highly optimize this

code before doing that). Open Source Robotic Arm (uses a servo controller as well as the Arduino)
http://ardx.org/RARM

int servoPin = 9;

void setupQ{ ) Servo Walker
\} pinMode(servoPin,OUTPUT); http://ardx.org/SEWA

MORE, MORE, MORE:
More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC04




.:8 More LEDs.:.
.. 74HC595 Shift Register:.

WHAT WE'RE DOING:

Time to start playing with chips, or integrated circuits (ICs) as they like to
be called. The external packaging of a chip can be very deceptive. For
example, the chip on the Arduino board (a microcontroller) and the one we
will use in this circuit (a shift register) look very similar but are in fact rather
different. The price of the ATMega chip on the Arduino board is a few dollars
while the 74HC595 is a couple dozen cents. It's a good introductory chip, and once you're comfortable playing
around with it and its datasheet (available online http://ardx.org/74HC595 ) the world of chips will be your oyster.
The shift register (also called a serial to parallel converter), will give you an additional 8 outputs (to control LEDs
and the like) using only three Arduino pins. They can also be linked together to give you a nearly unlimited
number of outputs using the same four pins. To use it you “clock in” the data and then lock it in (latch it). To do
this you set the data pin to either HIGH or LOW, pulse the clock, then set the data pin again and pulse the clock
repeating until you have shifted out 8 bits of data. Then you pulse the latch and the 8 bits are transferred to the
shift registers pins. It sounds complicated but is really simple once you get the hang of it.

(for a more in depth look at how a shift register works visit: http://ardx.org/SHIF) j

THE CIRCUIT:

CIRC-05

. - Shift Register
Breadboard Sheet )2(4P|n Header “ 74HC595 /'—\ Wire
x1

x1

560 Ohm Resistor
Green-Blue-Brown
x8

pin pin pin +5 volts
4 3 2
74H|C595

Red LED
x8

LED
resistor
(5600hm)

+5V

(ground) (-)

_I_ gnd

There is a half moon
cutout, this goes at the top.
Poke holes in sheet with
pen to make IC insertion
easier!

e

~N O UhA WNEFE O

|

.:download:.
breadboard layout sheet
http://ardx.org/BBLS05
.view:.
assembly video
http://ardx.org/VIDEOS




COD E (no need to type everything in just click)

Download the Code from ( http://ardx.org/CODEOQO5 )
(copy the text and paste it into an empty Arduino Sketch)

//Pin Definitions
//The 74HC595 uses a serial communication

//link which has th i
intlgatg lcz; as e e digitalWrite(latch, LOW);

int clock = 3; )
int latch = 4; //Pulls the chips latch low

’ shiftOout(data, clock, MSBFIRST, value);
void setup() //runs once //Shifts out 8 bits to the shift register

pinMode(data, OUTPUT); - 3
pinMode(clock, OUTPUT); digitalWrite(latch, HIGH); ) )
pinMode(latch, OUTPUT); } //Pulls the latch high displaying the data

void loop() // run over and over again

int delayTime = 100;
//delay between LED updates
for(int 1 = 0; 1 < 256; i++){
updatelLEDs(i1);
delay(delayTime); 3}

/*
* updateLEDs() - sends the LED states set
* in value to the 74HC595 sequence

*/
\Xgid updateLEDs(int value){

( NOT WORKING? (3 things to try) \

4 Y é N

P Frustration?
The Arduino’s power . .
P Not Quite Working Shoot us an e-mail, this circuit
LED goes out

This h dt | Sorry to sound like a broken is both simple and complex at
ftls appterr]le ous e:]coutpr:e record but it is probably the same time. We want to
o1 imes, It Nappens when the something as simple as a hear about problems you have

chip is inserted backwards. If

ou fix it quickly nothing will crossed wire. 50 we can address them in
y! q X yk g future editions.
reak.

help@oomlout.com

\J 2/

Doing it the hard way: //between LED updates
i i icti ; for(int i = 0; 1 < 8; i++){
An Arduino makes rather complex actions very easy, shifting out data is changeLED(i .ON) ;
one of these cases. However one of the nice features of an Arduino is delay(delayTime);
. . . . 3
you can make things as easy or difficult as you like. Let's try an TorGint i = 0; i < 8; i++){

example of this. In your loop switch the line: changeLED(i,0FF);
updatelLEDs(i) -> updateLEDsLong(i); delay(delayTime);
Upload the program and notice nothing has changed. If you look at the

code you can see how we are communicating with the chip one bit at a
time. (for more details http://ardx.org/SPI ).

Uploading this will cause the lights to light up one after another and then off
in a similar manner. Check the code and wikipedia to see how it works, or
shoot us an e-mail if you have questions.

Controlling individual LEDs:

Time to start controlling the LEDs in a similar method as we did in
CIRCO02. As the eight LED states are stored in one byte (an 8 bit value)
for details on how this works try http://ardx.org/BINA. An Arduino is
very good at manipulating bits and there are an entire set of operators
that help us out. Details on bitwise maths ( http://ardx.org/BITW ).

More animations:
Now things get more interesting. If you look back to the code from CIRC02 (8

LED Fun) you see we change the LEDs using digitalWrite(led, state), this is
the same format as the routine we wrote changeLED(led, state). You can use
the animations you wrote for CIRC02 by copying the code into this sketch and
changing all the digitalWrite()'s to changeLED()'s. Powerful? Very. (you'll also
Our implementation. need to change a few other things but follow the compile errors and it works

Replace the loop() code with itself out).
int delayTime = 100; //the number of milliseconds

\ //to delay j

MORE, MORE, MORE:
More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO5




.:Music:.
.:Piezo Elements..

WHAT WE'RE DOING:

To this point we have controlled light, motion, and

electrons. Let's tackle sound next. But sound is an

analog phenomena, how will our digital Arduino cope?

We will once again rely on its incredible speed which will let it

mimic analog behavior. To do this, we will attach a piezo element to one of the
Arduino's digital pins. A piezo element makes a clicking sound each time it is pulsed
with current. If we pulse it at the right frequency (for example 440 times a second to
make the note middle A) these clicks will run together to produce notes. Let's get to
experimenting with it and get your Arduino playing "Twinkle Twinkle Little Star".

THE CIRCUIT:

CIRC-06 § 2PinHeader . Piezo Element

Breadboard Sheet a 1 /—\ Wire

x1

Arduino
pin 9

Piezo
Element

gnd
(ground) (-)

.:download:.
breadboard layout sheet
http://ardx.org/BBLS06
view:.
assembly video
http://ardx.org/VIDEO6




CO D E (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)

/* Melod
(cleft) 2005 D. Cuartielles for K3

* *

This example uses a piezo speaker to play melodies. It sends
a square wave of the appropriate frequency to the piezo,
generating the corresponding tone.

The calculation of the tones is made following the
mathematical operation:

timeHigh = period /7 2 = 1 / (2 * toneFrequency)
where the different tones are described as in the table:

ote frequency period timeHigh
261 Hz

n
©
d
e
f
g
a
b
c

F bk b b b b R b R 3k b R X b R X b X O F X %

http://www.arduino.cc/en/Tutorial/Melody

int speakerPin = 9;

int length = 15; // the number of notes

char notes[] = "ccggaagffeeddc "; // a space represents a rest
int beats[] = { 1, 1 1, 2,1, 1, 1,1, 1,1, 2, 4 };
int tempo = 300;

void playTone(lnt tone,
for (long i = 0; i < duration * 1000L;
K dlgltaIerte(speakerPln HIGH) ;

int duration) {
i += tone * 2) {

Download the Code from ( http://ardx.

org/CODEOQ6 )

digitalWrite(speakerPin,
LOW) ;
delayMicroseconds(tone);

3
3
void playNote(char note

char names[] = { * “d- ‘g"
int tones[] = { 1915 1700 1519 1432 1275,

int duratlon) {
T

// play the tone corresponding to the note name
for (int i = 0; i < 8; i++) {
if (names[i] == note) {
playTone(tones[i], duration);

3
3

void setu

d PO { _
pinMode(speakerPin, OUTPUT);

void loop(Q) {
for (int i = 0; i++) {
if (notes[l]
delay(beats[l] * tempo); // rest
} else
playNote(notes[i], beats[i] * tempo);

| < Iength

// pause between notes
delay(tempo / 2); 3}

5 }:
’1136, 1014, 956

delayMicroseconds(tone);
[ NOT WORKING? (3 things to try)

q N\

No Sound
Given the size and shape of
the piezo element it is easy to
miss the right holes on the
breadboard. Try double
checking its placement.

Can't Thin

program then

Melody is Playing?
Just pull up the piezo element
whilst you think, upload your

Tired of Twinkle Twinkle

Little Star?
The code is written so you can

easily add your own songs,
check out the code below to
get started.

k While the

plug it back in.

\J

2/

" MAKING IT BETTER

Playing with the speed:

The timing for each note is calculated based on
variables, as such we can tweak the sound of each note
or the timing. To change the speed of the melody you

need to change only one line.
int tempo = 300; ---> int tempo = (new #)
Change it to a larger number to slow the melody down,

or a smaller number to speed it up.
Tuning the notes:
If you are worried about the notes being a little out of

tune this can be fixed as well. The notes have been
calculated based on a formula in the comment block at
the top of the program. But to tune individual notes just
adjust their values in the tones[] array up or down
until they sound right. (each note is matched by its
name in the names[] (array ie. c = 1915)

\_

c,

e,

char names[] a,
-cr

int tones[]
1014, 956 };

Composing your own melodies:
The program is pre-set to play ‘Twinkle Twinkle Little Star'

however the way it is programmed makes changing the song
easy. Each song is defined in one int and two arrays, the int
length defines the number of notes, the first array
notes[] defines each note, and the second beats[]

defines how long each note is played. Some Examples:

Twinkle Twinkle Little Star

int length = 15;

char notes[] = {"ccggaagffeeddc "};

int beats[]1 = {1, 1, 1, 1, 1,
1, 1, 2, 4 3};

Happy Birthday (flrst line)

int length o

char notes[] = {"ccdcfeccdcgf "};

int beats[] = {1,1,1,1,1,2,1,1,1,1,1,2,4};

={ dr, “Fr, "g",

{ 1915, 1700, 1519, 1432, 1275, 1136,

Ay 2o dg iy i, g

b,

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.

org/CIRCO6




..Button Pressing..
.:Pushbuttons:.

WHAT WE'RE DOING:

Up to this point we have focused entirely on outputs, time to

get our Arduino to listen, watch and feel. We'll start with a

simple pushbutton. Wiring up the pushbutton is simple. There is
one component, the pull up resistor, that might seem out of place.
This is included because an Arduino doesn't sense the same way we do (ie button pressed,
button unpressed). Instead it looks at the voltage on the pin and decides whether it is HIGH
or LOW. The button is set up to pull the Arduino's pin LOW when it is pressed, however, when
the button is unpressed the voltage of the pin will float (causing occasional errors). To get the
Arduino to reliably read the pin as HIGH when the button is unpressed, we add the pull up
resistor.

\ (note: the first example program uses only one of the two buttons) j

THE CIRCUIT:

CIRC-07 2 Pin Header ,"",’L Pushbutton

Breadboard Sheet ﬁ' x4 - X2 /—\ Wire
X1 1

Red LED
x1

Brown-Black-Orange = Green-Blue-Brown

10k Ohm Resistor g 560 Ohm Resistor *
X2 x1

Arduino
pin 2 pin 3

Arduino +5 volts
pin 13
AAA AAA

\AA e AA A4

resistor
LED (10k ohm)

] A

resistor p:Jshbutton
(5600hm)

— gnd
\ (ground) (-) /

S

.:download:.
breadboard layout sheet
http://ardx.org/BBLS07
view:.
assembly video
http://ardx.org/VIDEO7




COD E (no need to type everything in just click)

CIRC-0Ov7

File > Examples > 2.Digital > Button
(example from the great arduino.cc site, check it out for other great ideas)

/*
* Button
by DojoDave <http://www.0jO.org>

Turns on and off a light emitting diode(LED) connected to digital
pin 13, when pressing a pushbutton attached to pin 7.
http://www.arduino.cc/en/Tutorial/Button

*/
int ledPin = 13;
int inputPin = 2;

void setup()
pinMode(ledPin,
pinMode(inputPin,

void loop({

val = digitalRead(inputPin); // read input value
if (val == HIGH) { // check if the input is HIGH
LOW); // turn LED OFF

HIGH); // turn LED ON

digitalWrite(ledPin,
} else {
digitalWrite(ledPin,

\

// choose the pin for the LED
// choose the input pin (for a pushbutton)
int val = 0; // variable for reading the pin status

OUTPUT) ; // declare LED as output
INPUT) ; // declare pushbutton as input

J

( NOT WORKING? (3 things to try)

~

( ) (
Light Not Turning On
The pushbutton is square
and because of this it is easy
to put it in the wrong way.
Give it a 90 degree twist and
see if it starts working.

Light Not Fading
A bit of a silly mistake we
constantly made, when you
switch from simple on off to
fading remember to move the
LED wire from pin 13 to pin 9.

\

Underwhelmed?
No worries these circuits are all

super stripped down to make

playing with the components
easy, but once you throw them
together the sky is the limit.

\J

2/

4 MAKING IT BETTER

On button off button:
The initial example may be a little underwhelming (ie. |

don't really need an Arduino to do this), let's make it a
little more complicated. One button will turn the LED on

the other will turn the LED off. Change the code to:

int ledPin = 13; // choose the pin for the LED
int inputPinl = 3; // button 1

int inputPin2 = 2; // button 2

void setup() {
pinMode(ledPin,
pinMode(inputPinl,
pinMode(inputPin2,

OUTPUT) ;
INPUT); // make button 1 an input
INPUT); // make button 2 an input

// declare LED as output

void loop(){
if (digitalRead(inputPinl) == LOW)
digitalWrite(ledPin, LOW); // turn LED OFF
} else if (digitalRead(inputPin2) == LOW) {
digitalWrite(ledPin, HIGH); // turn LED ON

}
Upload the program to your board, and start toggling the

\LED on and off.

Fading up and down:

Lets use the buttons to control an analog signal. To do this
you will need to change the wire connecting the LED from pin
13 to pin 9, also change this in code.

int ledPin = 13; ----> int ledPin = 9;
Next change the loop() code to read.

int value = 0;
void loop(){
if (digitalRead(inputPinl) == LOW) { value--; }
else if (dlgltalRead(lnputPlnz) == LOwW) { value++; }
value = constrain(value, 0, 255);
analogWrite(ledPin, value);
} delay(10);

Changing fade speed:
If you would like the LED to fade faster or slower, there is only

one line of code that needs changing;
delay(10); ----> delay(new #);

To fade faster make the number smaller, slower requires a
larger number.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO7




.- Twisting:.
.:Potentiometers:.

WHAT WE'RE DOING:

Along with the digital pins, the Arduino also has 6
pins which can be used for analog input. These
inputs take a voltage (from 0 to 5 volts) and convert
it to a digital number between 0 (0 volts) and 1023 (5 volts) (10 bits of
resolution). A very useful device that exploits these inputs is a potentiometer
(also called a variable resistor). When it is connected with 5 volts across its
outer pins the middle pin will read some value between 0 and 5 volts
dependent on the angle to which it is turned (ie. 2.5 volts in the middle). We
Qan then use the returned values as a variable in our program. )

THE CIRCUIT:

CIRC-08 I Potentiometer

Breadboard Sheet ﬁl )2(4P|n Header 0 10k ohm

x1 x1

o 560 Ohm Resistor
reen LED Green-Blue-Brown
X1 x1

Arduino +5 \:?Its

pin 13

Arduino

. analog
Potentiometer pin 0

g (light
emittin €——
diode)

resistor (5600hm)
(green-blue-brown)

—
— gnd
\‘ (ground) (-)

.:download:.
breadboard layout sheet
http://ardx.org/BBLS08
view:.
assembly video
http://ardx.org/VIDEO8




COD E (no need to type everything in just click)

File > Examples > 3.Analog > Analoglnput
(example from the great arduino.cc site, check it out for other great ideas)

/* Analog Input
* Demonstrates analog input by reading an analog sensor on analog
* pin 0 and turning on and off a light emitting diode(LED) connected to
digital pin 13.
* The amount of time the LED will be on and off depends on the value obtained by
* analogRead() -
* Created by David Cuartielles
Modified 16 Jun 2009
By Tom lgoe
http://arduino.cc/en/Tutorial/Analoglnput
*
/

int sensorPin = 0;
int ledPin = 13;
int sensorValue =

// select the input pin for the potentiometer
// select the pin for the LED
0; // variable to store the value coming from the sensor
void setup

) {
pinMode(ledPin, OUTPUT); //declare the ledPin as an OUTPUT:

void loop(Q) {
sensorValue = analogRead(sensorPin);//
digitalWrite(ledPin, HIGH); //
delay(sensorValue); //
digitalWrite(ledPin, LOW); //
delay(sensorValue); //

the
the
the
the
the

value from the sensor:
ledPin on

program for
ledPin off:
program for

<sensorValue> milliseconds:

for <sensorValue> milliseconds:

\_

( NOT WORKING? (3 things to try)

( ) (
Sporadically Working
This is most likely due to a
slightly dodgy connection with
the potentiometer's pins. This
can usually be conquered by
taping the potentiometer down.

Not Working
Make sure you haven't
accidentally connected the
potentiometer's wiper to digital
pin 2 rather than analog pin 2.
(the row of pins beneath the
power pins)

Still Backward
You can try operating the

circuit upside down.
Sometimes this helps.

\J

4 MAKING IT BETTER

Threshold switching:
Sometimes you will want to switch an output when a value

exceeds a certain threshold. To do this with a
potentiometer change the 1oop() code to.

void loop() {
int threshold = 512;
if(analogRead(sensorPin) > threshold){
digitalWrite(ledPin, HIGH);}
else{ digitalWrite(ledPin, LOW);}

This will cause the LED to turn on when the value is above

512 (about halfway), you can adjust the sensitivity by

changing the threshold value.

Fading:

Let's control the brightness of an LED directly from the
potentiometer. To do this we need to first change the pin
the LED is connected to. Move the wire from pin 13 to pin

int ledPin = 13; ----> int ledPin = 9;

K9 and change one line in the code.

Then change the loop code to.
void loop() {

int value = analogRead(potPin) 7/ 4;

analogWrite(ledPin, value);
Upload the code and watch as your LED fades in relation to
your potentiometer spinning. (Note: the reason we divide the
value by 4 is the analogRead() function returns a value from 0
to 1023 (10 bhits), and analogWrite() takes a value from O to
255 (8 hits) )
Controlling a servo:
This is a really neat example and brings a couple of circuits
together. Wire up the servo like you did in CIRC-04, then open
the example program Knob (File > Examples > Servo >

Knob ), then change one line of code.

int potpin = 0; ----> int potpin = 2;
Upload to your Arduino and then watch as the servo shaft turns
as you turn the potentiometer.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCOS8




..Light:.
.:Photo Resistors:.

WHAT WE'RE DOING:

Whilst getting input from a potentiometer can be useful

for human controlled experiments, what do we use

when we want an environmentally controlled

experiment? We use exactly the same principles but instead
of a potentiometer (twist based resistance) we use a photo resistor (light based
resistance). The Arduino cannot directly sense resistance (it senses voltage) so we
set up a voltage divider (http://ardx.org/VODI). The exact voltage at the sensing

pin is calculable, but for our purposes (just sensing relative light) we can

experiment with the values and see what works for us. A low value will occur when
Qhe sensor is well lit while a high value will occur when it is in darkness. j

THE CIRCUIT:

CIRC-09 L‘ 2 Pin Header @ photo-Resistor

E;-eadboard Sheet %4 | | 1 /'—\ Wire

Green LED
X1

Brown-Black-Orange & Green-Blue-Brown

10k Ohm Resistor . D60 Ohm Resistor @
X1 X1

Arduino

pin 13 +5 volts

resistor
(10k ohm)
=~ LED Arduino
analog
pin 0
resistor

s
(5600hm) < < Photo

‘C resistor

.:download:.
breadboard layout sheet
http://ardx.org/BBLS09
.view:.
assembly video
http://ardx.org/VIDEO9




COD E (no need to type everything in just click)

(copy the text and paste it into an empty Arduino Sketch)
/*
* A simple programme that will change the
* intensity of an LED based on the amount of
* light incident on the photo resistor.

*

*/

//PhotoResistor Pin
int lightPin = 0; //the analog pin the
//photoresistor is
//connected to
//the photoresistor is not
//calibrated to any units so
//this is simply a raw sensor
//value (relative light)
//LED Pin
int ledPin = 9;//the pin the LED is connected to
//we are controlling brightness so
//we use one of the PWM (pulse
//width modulation pins)

void setup(Q

pinMode(ledPin, OUTPUT); //sets the led pin to

Download the Code from ( http://ardx.org/CODEQ9 )

//output

/*
* loop() - this function will start after setup
* finishes and then repeat
*
/
void loop(Q)

int lightLevel = analogRead(lightPin); //Read the
// lightlevel
lightLevel = map(lightLevel, 0, 900, 0, 255);
//adjust the value 0 to 900 to O to 255
lightLevel = constrain(lightLevel, 0, 255);
//make sure the value is betwween 0 and 255
analogWrite(ledPin, lightLevel); //write the value
3

( NOT WORKING? (3 things to try)

( ) (
LED Remains Dark
This is a mistake we continue
to make time and time again,
if only they could make an LED
that worked both ways. Pull it
up and give it a twist.

It Isn't Responding to
Changes in Light.

Given that the spacing of the
wires on the photo-resistor is
not standard, it is easy to
misplace it. Double check its in

the right place. try.

p
Still not quite working?

You may be in a room which is
either too bright or dark. Try
turning the lights on or off to

see if this helps. Or if you have

a flashlight near by give that a

\J
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4 MAKING IT BETTER

Reverse the response:

Perhaps you would like the opposite response. Don't

worry we can easily reverse this response just change:
analogWrite(ledPin, lightLevel); ---->
analogWrite(ledPin, 255 - lightLevel);

Upload and watch the response change:

Night light:
Rather than controlling the brightness of the LED in

response to light, let's instead turn it on or off based on

a threshold value. Change the loop() code with.
void loop(){
int threshold = 300;
if(analogrRead(lightPin) > threshold){
digitalWrite(ledPin, HIGH);

Yelse{
} digitalWrite(ledPin, LOW);

K}

Light controlled servo:

Let's use our newly found light sensing skills to control a
servo (and at the same time engage in a little bit of Arduino
code hacking). Wire up a servo connected to pin 9 (like in
CIRC-04). Then open the Knob example program (the same
one we used in CIRC-08) File > Examples > Servo >
Knob. Upload the code to your board and watch as it works

unmodified.
Using the full range of your servo:
You'll notice that the servo will only operate over a limited

portion of its range. This is because with the voltage dividing
circuit we use the voltage on analog pin 0 will not range from
0 to 5 volts but instead between two lesser values (these
values will change based on your setup). To fix this play with
the val = map(val, 0, 1023, 0, 179); line. For hints on what to
do visit http://arduino.cc/en/Reference/Map .

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRCO9




.. Temperature:.

.:TMP36 Precision Temperature Sensor:.

WHAT WE’RE DOING:

What's the next phenomena we will measure with our
Arduino? Temperature. To do this we'll use a rather
complicated IC (integrated circuit) hidden in a package
identical to our P2N2222AG transistors. It has three pin's,
ground, signal and +5 volts, and is easy to use. It outputs 10
millivolts per degree centigrade on the signal pin (to allow measuring temperatures below
freezing there is a 500 mV offset eg. 25° C = 750 mV, 0° C = 500mV). To convert this from the
digital value to degrees, we will use some of the Arduino's maths abilities. Then to display it
we'll use one of the IDE's rather powerful features, the debug window. We'll output the value
over a serial connection to display on the screen. Let's get to it.

One extra note, this circuit uses the Arduino IDE's serial monitor. To open this, first upload the
program then click the button which looks like a magnifying glass or press (ctrl + shift + m)

The TMP36 Datasheet: — -
Qttp://ardx.org/TMPSG 3 )

THE CIRCUIT:

CIRC-10
Breadboard Sheet
X1

TMP36
I Temperature Sensor Wire
I x1 {‘_‘\
Schematic

Arduino
analog 9+5 volts

pin 0

e~ TMP36 - L -
v N (precision . L, g the chip will have
Sgéa temperature . AR TMP36 printed on it
sensor) : o
r: 3 -"_ 1.

—1 _ gnd

F‘ 2 Pin Header
x4

\ — (ground)y

The Internet

.:download:.
breadboard layout sheet
http://ardx.org/BBLS10
.view:.
assembly video
http://ardx.org/VIDE10

/




COD E (no need to type everything in just click)

Download the Code from ( http://ardx.org/CODE10 )

(copy the text and paste it into an empty Arduino Sketch)

| Arduino Experimentation Kit Example Code |
] CIRC-10 .: Temperature :.

A simple program to output the current temperature
to the IDE"s debug window
For more details on this circuit:

//TMP36 Pin Variables

int temperaturePin = 0;//the analog pin the TMP36"s
//Vout pin is connected to
//the resolution is
//10 mV / degree centigrade
//(500 mV offset) to make
//negative temperatures an

option

void setup()

Serial .begin(9600); //Start the serial connection

//with the computer

//to view the result open the

//serial monitor

//last button beneath the file

//bar (looks like a box with an

//antenna)

}

\_

void loop()
// run over and over again

float temperature = getVoltage(temperaturePin);
//getting the voltage reading from the
//temperature sensor

temperature = (temperature - .5) * 100;//converting from 10
mv
//per degree wit 500 mV offset to
//degrees ((volatge - 500mV) times
100)
Serial .printIn(temperature); //printing the result
delay(1000); //waiting a second

/*

* getVoltage() - returns the voltage on the analog input

* defined by pin

*/

float getVoltage(int pin){

return (analogRead(pin) * .004882814);//converting from a O

//to 1024 digital range
// to 0 to 5 volts
//(each 1 reading equals ~ 5

millivolts

: J

( NOT WORKING? (3 things to try)

~

4 "

Nothing Seems to Happen
This program has no outward

indication it is working. To see
the results you must open the

Arduino IDE's serial monitor.
(instructions on previous page)

[ Gibberish is Displayed )
This happens because the serial
monitor is receiving data at a
different speed than expected.
To fix this, click the pull-down
box that reads "*** baud" and
change it to "9600 baud".

~
Temperature Value is
Unchanging
Try pinching the sensor with
your fingers to heat it up or
pressing a bag of ice against it
to cool it down.

\J
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4 MAKING IT BETTER

Outputting voltage:

This is a simple matter of changing one line. Our
sensor outputs 10mv per degree centigrade so to get
voltage we simply display the result of getVoltage().

delete the line

Outputting degrees Fahrenheit:
Again this is a simple change requiring only maths. To

go degrees C ----> degrees F we use the formula:
(F=C=*18)+ 32)
add the line
temperature =
(((temperature - .5) * 100)*1.8) + 32;
before Serial.printin(temperature);

More informative output:
Let's add a message to the serial output to make what

us appearing in the Serial Monitor more informative. To

temperature = (temperature - .5) * 100;

do this first revert to the original code then change:
Serial _println(temperature);

Serial .print(temperature);
Serial .printIn(*" degrees centigrade™);

The change to the first line means when we next output it
will appear on the same line, then we add the informative

text and a new line.
Changing the serial speed:
If you ever wish to output a lot of data over the serial line

time is of the essence. We are currently transmitting at 9600
baud but much faster speeds are possible. To change this

change the line:
Serial .begin(9600); ----> Serial.begin(115200);

Upload the sketch turn on the serial monitor, then change
the speed from 9600 baud to 115200 baud in the pull down
menu. You are now transmitting data 12 times faster.

J

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC10




..Larger Loads:.
.:Relays:.

WHAT WE’RE DOING:

The final circuit is a bit of a test. We combine what we learned
about using transistors in CIRCO03 to control a relay. A relay is
an electrically controlled mechanical switch. Inside the little
plastic box is an electromagnet that, when energized, causes a
switch to trip (often with a very satisfying clicking sound). You can buy relays that vary in size
from a quarter of the size of the one in this kit up to as big as a fridge, each capable of
switching a certain amount of current. They are immensely fun because there is an element of
the physical to them. While all the silicon we've played with to this point is fun sometimes you
may just want to wire up a hundred switches to control something magnificent. Relays give you
the ability to dream it up then control it with your Arduino. Now to using today's technology to

\COI’IUO| the past. (The 1N4001 diode is acting as a flyback diode, for details on why it's there visit: http://ardx.org/4001) j

THE CIRCUIT:

CIRC-11 Diode . Transistor
“ Breadboard Sheet (1N4001) I P2N2222AG (T0O92) ‘
x1 x1 foxa

Red-Red-Red : Green-Blue-Brown
x1 X2

Green LED Red LED
x1

2.2k Ohm Resistor 560 Ohm Resistor ﬁ

2 Pin Header
x4 J
Schematic

Arduino
pin 2

resistor Poke holes through the
(2.2kohm) paper to make mounting

. the relay easier
Transistor Y

Base| P2N2222AG _
Colletor Emitter R | the transistor will have

: P2N2222AG printed on it
g Diode ST (some variations will have
= (flyback) ' : the pin assignment reversed)

‘ |+5 volts

gnd ——
(ground) (-) —

.:download:.
breadboard layout sheet
http://ardx.org/BBLS11
view:.
assembly video
http://ardx.org/VIDE11




CODE (no need to type everything in just click) C I R C —_— 1 1
File > Examples > 1.Basic > Blink

(example from the great arduino.cc site, check it out for other great ideas)
/*

Blink

The basic Arduino example. Turns on an LED on for one second,
then off for one second, and so on... We use pin 13 because,
depending on your Arduino board, it has either a built-in LED
or a built-in resistor so that you need only an LED.

http://www.arduino.cc/en/Tutorial/Blink

ok ok ok ok o % % %
N

int ledPin = 2; [/ FEFEFFREEEIR CHANGE TO PIN 2 *ssdsktkkdk
void setup(Q) // run once, when the sketch starts

pinMode(ledPin, OUTPUT); // sets the digital pin as output

void loop(Q) run over and over again
digitalWrite(ledPin, HIGH); sets the LED on
delay(1000) ; waits for a second

digitalWrite(ledPin, LOW); sets the LED off
delay(1000); waits for a second

\_ )

( NOT WORKING? (3 things to try) \

4 \ [

Not Quite Working

Nothing Happens
The example code uses pin 13
and we have the relay
connected to pin 2. Make sure
you made this change in the
code.

No Clicking Sound
The transistor or coil portion of

the circuit isn't quite working.
Check the transistor is plugged
in the right way.

These relays are designed to
be soldered, not mounted to a
breadboard. You will most
likely need to press on it to
keep in fully in contact with
the breadboard

\J
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4 MAKING IT BETTER

Watch the Back-EMF Pulse

turns off.

Controlling a Motor

(remember to bypass the 560 Ohm resistor).

Controlling Motor Direction
A bit of a complicated improvement to finish.

To do this manually we reverse the leads. To

Replace the diode with an LED. You'll see it blink each time it “snubs” the coil voltage spike when it

In CIRC-03 we controlled a motor using a transistor. However if you want to control a larger motor a (2.2kohm)
relay is a good option. To do this simply remove the red LED, and connect the motor in its place

To control the direction of spin of

a DC motor we must be able to reverse the direction of current flow through it.

do it electrically we require

something called an h-bridge. This can be done using a DPDT relay to control
the motor's direction, wire up the following circuit. It looks complicated but can
kbe accomplished using only a few extra wires. Give it a try.

Arduino
pin 2
resistor

Transistor
sase | P2N2222AG

Collector

(flyback)

gnd —— /
(ground) ("= j

MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC11




.:Colorful Light:.
.:RGB LEDs..

WHAT WE'RE DOING:
You can blink an LED, and use PWM to control motors. Let’s
use these techniques to create practically any colours &
intensities you want with an RGB LED.

The RGB LED actually has 3 LED elements inside it - Red, Green & Blue. Let’s turn these
on in combinations to get some brilliant colours out of a single LED!

So you can see what is going on, this circuit has an LED tied into each channel so you can
see exactly what the different signals are doing to the RGB LED.

- J

THE CIRCUIT:

CIRC-RGB

pli i 2 Pin Head . 5mm RGB LED
" Breadboard Sheet ¥ ih Header <1 /"_"‘\ Wire
x1

560 Ohm Resistor Red LED
Orange-Orange-Brown X3
X6

resistors
RGB LED (se0om) |-

\AAAS

gnd

r \AAAZ

AAAA
\AAAS

otud 1T
ounpay

(pub) uowwod
uaalb

pal
anq

6ud

lgnd

l Nindicator
gnd =&

3}

.:download:.
breadboard layout sheet
http://ardx.org/BBLS12R




COD E (no need to type everything in just click)

Download the Code from (http://ardx.

org/CODE12R)

(copy the text and paste it into an empty Arduino Sketch)

//RGB LED pins

int ledDigitalOne[] = {9, 10, 11};
//the three digital pins of the digital LED
//9 = redPin, 10 = greenPin, 11 = bluePin

const boolean ON = LOW;
//Define on as LOW (this iIs because we use
//a common Anode RGB LED (common pin is
//connected to +5 volts)

const boolean OFF = HIGH;
//Define off as HIGH

//Predefined Colors

const boolean RED[] = {ON, OFF, OFF};
const boolean GREEN[] = {OFF, ON, OFF};
const boolean BLUE[] = {OFF, OFF, ON};
const boolean YELLOW[] = {ON, ON, OFF};
const boolean CYAN[] = {OFF, ON, ON};
const boolean MAGENTA[] = {ON, OFF ON}
const boolean WHITE[] = {ON, ON, ON
const boolean BLACK[] = {OFF, OFF OFF}

//An Array that stores the predefined colors

const boolean* COLORS[
{RED, GREEN, BLUE,YELLOW, CYAN, MAGENTA,
WHITE, BLACK};

\_

void setup(){
for(int 1 = 0; 1 < 3; i++){
pinMode(ledDigitalOne[i], OUTPUT);
//Set the three LED pins as outputs

3
}
void loop()

{
setColor(ledDigitalOne, CYAN);
//Set the color of the LED

//randomColor()
¥

void randomColor(){
int rand = random(0O, sizeof(COLORS) 7/ 2);
//get a random number within the range of
//colors
setColor(ledDigitalOne, COLORS[randl);
//Set the color of led one to a random color
delay(1000);

void setColor(int* led, boolean* color){
for(int 1 = 0; 1 < 3; i++){
dlgltaIerte(led[l] color[il]);

J

}

( NOT WORKING? (3 things to try)

~

4 \ [

LED Remains Dark or Se

Shows Incorrect Color
With four close pins on the
RGB LED, one might be not in
the right spot. Don't forget the
ground connections too!

LED may

try usin

The red diode within the RGB

than the other two. To make
your colors more balanced,

resistor (or two resistors in

eing Red Looking For More?
The indicator LEDs show
what signal is going to each
channel of the RGB LED.
Remove them when you know
how the channels work to mix

and create the colours.

be a bit brighter

g a higher ohm

series).

\J
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4 MAKING IT BETTER

More Colors
I imagine you are less than impressed by the

cyan glowing LED before you. To display a
different color change the color in the code to
one of the others.

setColor(ledDigitalOne, CYAN);
setColor(ledDigitalOne,

———
**NEW COLOR**) ;

Display a Random Color

Of course we can do more than display a
constant color, to see how we cycle through
random colors change the lToop() code to.

void loo

pO{ o
//setColor(ledDigitalOne, CYAN);
\

Analog Color Control
While switching between colors is good fun RGB LEDs

really come into their own when mixed with analog
control. Using PWM (pulse width modulation) it's
possible to produce nearly any color and fade
between them. Sadly the code for this is a bit too long
for the section above, for an example program (with
lots of comments).

randomColor()
MORE, MORE, MORE:

More details, where to buy more parts, where to ask more questions:

http://www.solarbotics.com




.:Notes.:.
..Room for a Few Notes:.

~




.:Notes.:.
.:Room for a Few Notes:.
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